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I ntroduction

Purpose

This document explains how to use the Proposal Generation Tool (PGT) software
to prepare a science proposal for use with the INTEGRAL Observatory. It explains
the use of the software from afunctional, rather than scientific, point of view.

Intended Reader ship

Observers wishing to apply for science time on INTEGRAL should familiarise
themselves with this document and keep it handy to use as areference. Proposals
for INTEGRAL can only be created and submitted by using the PGT software.

Using Online Help

The online help provides brief explanationsfor most of thefieldsinthe PGT and is
accessed from the Help menu (see section 2.3, page 6).

Using the SUM

This document provides more detailed explanations of the PGT functionality than
the online help can provide. However, the PGT isnot adifficult tool to use and once

you are familiar with the basics, you should not need to refer to this document very
often.

Conventions Used

The labels used for itemsin panels are shown in italics. Itemsin a panel which
cause an action to be performed are shown in bold.

Problem Reporting
If you discover a problem with the PGT, your first port of call should be the

Frequently Asked Questions (FAQ) page on the Integral Web Site (IWS) found at
this location:

http://astro.esa.int/Integral /isoc/

If this does not answer your query, then you can send amessage to the Helpdesk at
the following email address:

inthel p@rssd.esa.int



INTEGRAL Doc.No
1SOC Issue
Proposal Generation Tool SUM Date
Page No

: INT-SOC-SUM-018
1.1

: 3rd June 2003

12

161

162

ADS
AO
AP
CSsSw
DBOB
ECS
ED
EID
ESA
ESOC
ESTEC
FE
FOV
GO
GPC
GPS
CPWG
GUI
IASW
IBIS
ICD
ICCS
IFTS
INTEGRAL
|OP
1SO
1ISOC
ISDC
ISWT
JEM-X
LAN
MIRD
MOC
MOUT
MP
OBSW
OCS
OGS

Definitions, acronyms and abbreviations

Definition of Terms

The definition of termsis provided in [AD-2].

Acronyms

Archive and Distribution System
Announcement of Opportunity
Application Programming Interface
Common Services Software

Data Base of Observable Bins
Exposure Completion Status (file)
Event Designator

Experiment Interface Document
European Space Agency

European Space Operations Centre
European Space Technology and Research Centre
Front-End

Field of View

Genera Observer

Galactic Plane Core

Galactic Plane Survey

Core Programme Working Group
Graphical User Interface

Instrument Application Software
Gamma-ray Imager

Interface Control Document

|SOC Configuration Control System
INTEGRAL File Transfer System
International Gamma-Ray Astrophysics Laboratory
Initial Observations Parameters
Infrared Space Observatory
INTEGRAL Science Operations Centre
INTEGRAL Science Data Centre
INTEGRAL Science Working Team
X-ray Monitor

Local Area Network

Mission Implementation Requirements Document
Mission Operations Centre

Message Out

Mission Planner

On-board Software

Observation Completion Status (file)
Operational Ground Segment
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PAD
PAS
PDC
PGT
PH
PHS
Pl
POD
POS
PA

PS
PSF
SCMP
SGS
SGSIP
SGSM
SGSRD
SPI
SPMP
SPAP
SVT
SVVP
TAC
™
TOO
URL
Www

Optical Monitor Camera

OMC Pointing Parameters
Observation Scheduling System
Product Assurance

Proposal Administrative Data
Performance Analysis Subsystem
Problem Domain Component
Proposal Generation Tool

Proposal Handler

Proposal Handling System
Principal Investigator

Planning and Observation Data
Preferred Observation Sequence
Product Assurance

Project Scientist

Planning Skeleton File

Software Configuration Management Plan
Science Ground Segment

SGS Implementation Plan

Science Ground Segment Manager
SGS Requirements Document
Gamma-ray Spectrometer
Software Project Management Plan
Software Product Assurance Plan
System Validation Test

Software Verification and Validation Plan
Time Allocation Committee
Telemetry

Target Of Opportunity

Universal Resource Locator
World Wide Web



ISOC

INTEGRAL

Proposal Generation Tool SUM

Doc.No : INT-SOC-SUM-018
Issue 1.1

Date : 3rd June 2003
Page No 14

AD-1
AD-2
AD-3
AD-4
AD-5
AD-6
AD-7
AD-8
AD-9
AD-10
AD-11
AD-12

172

RD-1
RD-2
RD-3

RD-4
RD-5
RD-6
RD-7
RD-8
RD-9
RD-10

RD-11

Refer ences

Applicable documents

The following documents are applicable in their latest version (except PSS-05):

PSS-05-0
INT-SOC-DOC-002
INT-SOC-URD-001
INT-SOC-SRD-002
INT-SOC-PL-005
INT-SOC-PL-002
INT-SOC-PL-003
INT-SOC-1CD-001
INT-SOC-1CD-002
INT-MOC-SY S-1CD-0001
INT-SOC-DOC-003
INT-SOC-PL-004

Refer ence documents

INT-SOC-DOC-001
INT-SY S-MIS-TN-0002-SMD

BSSC ESA; Issue 1 Draft 2

INT-SR-1594
INT-PL-03197
INT-1C-A1-0005
INT-RP-A1-0030
INT-SAG-98-0042-TN

INT-SOC-DOC-023

ESA Software Engineering Standards, Issue 2
Definition of Observations Terms
ISOC URD

ISOC SRD

|SOC SPAP

|SOC SCMP

ISOC SVVP

ISOC - ISDC ICD

ISOC - OMCICD

OGS- SGSICD

| SOC infrastructure

|SOC SPMP

| SOC Operations Concept

INTEGRAL Mission Planning Concept

Coad P., Yourdon E; Object-Oriented Design;
Prentice Hall 1991

Guide To Applying ESA software engineering

standards to projects using OO Methods; July 1997

Design Patterns; Addison Wesley 1994;
GammakE. et Al.

SGS Requirement Document

SGS Implementation Plan

Satellite Database ICD

Packet Structure Definition

Instrument Modes and Mode Transitions Supported

by ISOC
JEM-X Observer's Manual
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2.1 Common Panel Layout

Every panel sharesacommon layout. Thislayout consists of amenu bar at the top
of the panel with anicon strip underneath it. Theicon strip usually containsthe ESA
logo, the ISOC logo and the Integral logo. Below theicon strip is a scrollable area
containing the main body of the panel. When apanel isfirst opened it will be shown
at its default size. If you resize the panel so that it is smaller than this default size,

scroll barswill automatically appear and you can use these to view the hidden parts
of the pandl.

I50C PGT: Observation Time Estimator

Menubar —— Panel Help

e S a  INTEGRAL . lcon strip
L Science Operations Centre

rinstrument Dither Pattern

|IBIS v“ M Staring
rCantinuum Energy (keV)—— rLine Energy {keV}
Min Max Energy Width
Scroll bars
Main body of panel | | | |

rFlux (photons!cmz.rs)—‘ "Signal o Noise—‘ "Exposurey_ 3

|'Right Ascension (decimal degrees) Declin%ﬂecimal d
| ull

-—— Message bar

Figurel Common Panel Layout

At the bottom of every panel isamessage bar. Informative messages may appear
here from time to time.

2.2 Mandatory Fields

Mandatory fields are fields which you must complete. They are denoted by a
coloured background. By default, they are coloured cyan, though you may choose
adifferent colour by editing the PGT.lax file (see section 8.2, page 26).

(]
r Street

| -

rCity ar Town I Mandatory
| i fields

- State rCountry A
| i

rF-mail Address

"Postal aor Zip Code

Figure2 Exampleof Mandatory Fields
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Help Menu

Menus are located on the menu bar at the top of every panel (see section 3.4.3, page
8, and section 3.5.2, page 9, for details of the different ways of accessing menus).

One menu which is common to all panelsin the PGT isthe Help menu. This menu
contains at least two entries: Panel and Overview.

The Panél entry causes a help panel to be displayed which provides information
about the panel to which the help menu belongs. The Overview entry opensahelp
panel which contains an overview of the major functionality in the PGT. This
overview is the same no matter which Help menu was used to activate it.

Overview Panel
e S a INTEGRAL %
Science Operations Centre

The Froposal CGeneration Toeol (PST) allows you to write a propozal to apply L]
for =cience time on the International Gamma-Ray As=trophy=icz Lakoratory

(INTEGRAL) .

The teool iz comprized of three main panselz where the body of the propo=zal i=
entered: the Admin Detailz FPanel, the Propo=al Details Fanel and the
Chzervation Details FPanel. In addition, there are tweo panslz which allow
access to the Chservation Time Estimator (OTE) tool and the Target Visikility
Predictor (TVF) tool. These five panels are accessed by selecting the

appropriate butten on the Main Fanel.

General Pointz:

. Information zhould ke entered into the boxes provided or chozen from the

pick-li=te.

Figure3 ExampleHelp Panel

Panel Menu

Every panel, except the Main Panel, contains a Panel menu with some or all of the
entries Reset, Print and Hide.

The Reset entry allows the user to reset all the inputs in the current panel to their
default values.

The Print entry allows the contents of some panels to be sent to a printer.

The Hide entry closesthe current panel, but preserves any data entered into any of
the fields. Thismeansthat if the panel is reopened, the data will be visible again.
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Proposal Generation Tool Basics

Installing the Proposal Generation Tool

The PGT iswritten in the Java programming language and, as such, is platform
independent, meaning that the same software will run on many operating systems
without modification. However, in order to ease installation on different platforms
and to alow local customisation of certain parameters, the PGT isprovided in a
variety of platform specific packages. These packages can be found on the Integral
Web Site (see section 1.5, page 1, for the URL).

To install the package for a given platform, follow the instructions in the
README.txt file which can also be found on the Integral Web Site.

Starting the Proposal Generation Tool

The method of starting the PGT depends on the platform in use. UNIX users start
the PGT by running a script, whereas Windows users double click on a desktop
icon. The README.txt file provides details of how to start the PGT.

Enabled and Disabled Fields

Certain fields can become disabled or enabled depending on which selections or
settingsare madeto other fieldsinapanel. When afield isdisabled, it isshownwith
gray text on agray background, and when it is enabled, it is shown with black text
on agray or coloured (if it isamandatory field) background.

| enavledfiad

Observation

Duration Dither Pattern

IU/' k= | -~
Enabled P [T]lr Observation Type
M Freferred Orientation
"\L '| From Ta
‘ I deg I deg
Disabled fields

Figure4 Enabled and Disabled Fields

Using the Mouse

The mouse is used to move an on-screen pointer and to trigger events, such as
activating menus and buttons, making selections from pick-lists, moving the input
focus from one field to another and changing the positions of scrollbars.
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34.1

34.2

34.3

34.4

Terminology

“Clicking” refersto pressing the left-hand mouse button while the pointer is over
an item you want to activate. For example, “click the OK button” means move the
pointer to the OK button and press (and release) the left-hand mouse button.

“Right-clicking” refersto clicking using the right-hand mouse button instead of the
left-hand one.

“Dragging” refers to holding a mouse button down whilst moving the pointer.

I nput Focus

Data can be entered into only onefield at atime. Similarly, only one button, menu
item or pick-list can be activated at atime. Theitem which is currently active, that
is, receiving input, is said to have the “input focus’. Text entry fields are signified
ashaving theinput focus by avertical bar (called the“caret”) which usually flashes.
Buttons and pick-lists have afaint rectangular box within them, if they have the
input focus. To transfer the input focus from one item to another, click on the item
you want to transfer the input focus to.

Menus

To open amenu, click on the name of the menu you wish to open in the menu bar
(seeFig. 1) of the panel. To select an entry from the menu, click on the entry. An
alternative way of making menu selectionsis to hold the mouse button down over
the menu bar and when the menu appears, drag the pointer to your selection; when
you release the mouse button, the entry under the pointer will be activated.

Pick-Lists
A pick-list can be opened by clicking onit. To make a selection from thelist, click
on the entry you want to select from the list.

State Paostal or Zip Code Gy

Click here to move

7 up the list

Drag the scrollbar
to move up or down
the list

E-mail Address

Metherlands
Mew Zealand

I MNarway

Telephone Number Fe{Poland

I |—F'orlugal

Romania

Russian Federation Click here to move

— down the list

Cao-Investigato
Serbia

{Names and affiliations anly}

[
Figure5 Using Pick-Lists

If the list has many entries, not all will be visible at once and a scrollbar will be
shown to the right of thelist. Y ou can use this scrollbar to make visible the entries
inthelist which are currently hidden. In order to make use of the scrollbar, you must
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3.5.2

not hold the mouse button down when you open the pick-list. If you do hold the
mouse button down and drag the pointer, you will only be able to select the entries
which are currently visible, because the pick-list will close as soon as you release
the mouse button.

Buttons and Check Boxes

To activate a button, just click on it. Similarly, to toggle the state of a check box,
click onit.

Using the Keyboard

It is possible to use the majority of the PGT using only the keyboard. Most of the
functionality of the mouse can be replicated with afew simple key presses.
However, the mouse may still be necessary to make the PGT windows activein the
desktop environment of your chosen platform.

Note that the SPACEBAR may be used in place of the ENTER key in the sections
which follow.

Input Focus

To movethe input focusfrom oneitem in apanel to another, pressthe TAB key on
the keyboard. Repeatedly pressing this key will cause the input focus to move to
each item in turn. To reverse the direction in which the input focus cycles, hold
down the SHIFT key whilst pressing the TAB key.

Menus

Look at Fig. 6 and notice that the initial letter of each of the menu names on the
menu bar is underscored. The underscored |etter can be used in combination with
the ALT key to open the menu. For example, to open the Panel menu, hold down
the ALT key and pressthe P key.

IS0C PGT: Observation Details Panel

Panel | Observation Help

Reset Gt +R INTEGRAL
Print | All Observations cii+p Erations Centre
Hide Gt +E Current Observation Total Time
ot Sumnary | | I—lﬂks
Observation Detail =
[ =

Figure6 Accessing Menus Using the Keyboard

Once amenu is open, the UP-ARROW and DOWN-ARROW cursor keys can be
used to highlight entries in the menu. To select an entry, use the cursor keys to
highlight it, then pressthe ENTER key. Alternatively, just press the |etter key
which corresponds to the underscored |etter for the menu entry you wish to select.
For example, to select the Reset entry in the open Panel menu, just pressthe R key.
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3.6

Similarly, to open the Print submenu, pressthe T key. Note that any letter in the
name of the menu entry may be underscored, not just the initial letter.

Some menu entries have keyboard shortcuts (known as accel erators) which are
shown to the right of the entry in amenu. For example, to reset the contents of the
Observation Details Panel (Fig. 6) press and hold the CTRL (Control) key then
press the R key. This can be done whenever the window is active, that is, you do
not need to open amenu first. A complete list of keyboard acceleratorsis shown in
Appendix A.

Pick-Lists

To open a pick-list using the keyboard, press the TAB key until the pick-list gains
the input focus (see section 3.4.2, page 8, and section 3.5.1, page 9) then pressthe
ENTERkey. Totraversethelist, usethe UP-ARROW and DOWN-ARROW cursor
keys. When your chosen entry is highlighted, press the ENTER key to select it.

Buttons and Check Boxes

A button can be activated by pressing the TAB key until the button has the input
focus (see section 3.4.2, page 8, and section 3.5.1, page 9), then pressing the
ENTER key. To toggle the state of a check box, pressthe TAB key until the check
box has the input focus, then press the SPACEBAR (not the ENTER key).

Textfields

To enter text into atextfield, ensure it has the input focus (see section 3.4.2, page
8, and section 3.5.1, page 9) before typing. Some textfields only allow numbersto
be entered, otherswill allow any character. All textfields have a maximum number
of characters (including spaces and carriage returns) which may be entered and you
will hear abeep when thislimit is reached. Some textfields also limit the number
of lines which may be entered i.e. you can press ENTER only alimited number of
times. Note that textfields may sometimes resize themselves within a panel while
you type. This allows the componentsin a panel to make the best use of the
available space for the input you have entered.

Exiting the Proposal Generation Tool

The PGT can be exited by selecting the Exit menu entry from the File menu in the
Main Panel (seeFig. 7), or by pressing and holding the CTRL key and then pressing
the E key while the Main Panel is active.
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Figure7 TheFileMenu

If you have made changesto your proposal, you will be asked if you would like to
save your proposal before exiting.

|1SOC PGT: Quit —l

E Sawve proposal before exiting?

Click Yesto open the Save
dialogue and save your
proposal

e ] e oo SR

Click No to exit the PGT
without saving your changes

Figure8 TheQuit Dialogue
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4.2

Saving, Loading and Printing
Saving

A proposal may be saved at any time by selecting the Save menu entry in the File
menu of the Main Panel (see Fig. 7). Thiswill cause the Save dialogue to appear.

Current directory

Use the pick-list to make Move onelevel up Go to the “home” Create anew

3??';331@5 to other the directory tree directory folder/directory

Loak in:

o0 O—

[ Proposals N | o0 O—

T3 sub_directory
D my_propesal_1

Listof filesin =Y 0 0 onoen o

current directory

Click the Save button
to write the proposal
to the specified file

File name for saved —_ _
proposal e meme ™ [y_proposal_» || sewe

. ) Click Cancel to close the
Files of type: |A" A ) '| | el Save dialogue without

saving the proposal

Figure9 The Save Dialogue

The Save dialogue allowsyou to navigate around alocal filesystem. Theareainthe
centre of the display shows the files and directories contained in the current
directory. The current directory is shown in the pick-list at the top of the display.
Y ou can move between directories by double clicking on a directory icon or by
choosing a directory from the pick-list.

To save your proposal, type afile name into the box provided and click the Save
button. Thiswill save your proposal into the directory shown at the top of the
display using the file name you gave.

If you change your mind about saving a proposal, click the Cancel button.

L oading

Toload aproposal, select the Open menu entry in the File menu of the Main Panel
(seeFig. 7). The Open dialogue will appear and thislooks very similar to the Save
dialogue, described above. Indeed, you can navigate around your local filesystem
in exactly the same way as you would in the Save dialogue.

When you locate the proposal you wish to load, either double click on itsnamein
thefilelist, or click once on the name (the name will appear in the File name: box)
and click the Open button.
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Open —I

Look in: ] Propasals v| @ @ Ij EZEZ E:
Ijsub_l:lirec:tor_\,r
Double click on the [ my_proposal_1
proposal nameto load Y_praposal_
it into the PGT D my_proposal_2 If you dlick once on
ry_proposal_3 the proposal name, click
the Open button to load
it into the PGT
File name: |my_proposa I_2 | | Open T
Files of type: |AII Files .} v| | Cancel |
Figure10 The Open Dialogue
4.3 Printing
43.1 The Print Options Dialogue
The paper size and the font used for printing can be chosen using the Print Options
dialogue. To open this, select the Options menu entry from the Print submenu in
the File menu of the Main Panel (see Fig. 7).
Frint Options
Paper Size
Select paper size here ——p! | a) A4 (1 US letter %
Available Fonts
Serif ‘\i
ssuitbald T Choosethe font by
serif. boldita lic clicking on its name
serif.ita lic
Shayyal MT :
Shayyal MT Beld One =
Font Sample
The quick: brown for jumpe et the lary dog
Click the OK buit h Click Cancel to discard

Figure1ll ThePrint OptionsDialogue

Two paper sizes are supported, A4 and US letter. Click on the appropriate button at
the top of the dialogue to choose the paper size.

The central part of the dialogue lists the fonts available on your system. Thislist
will vary from one machine to another, but there are five standard fonts which are
available on every system. These are: Dialog, Dia oglnput, Monospaced, SansSerif
and Serif. A sample of the selected font is shown below the font list.

To make the selected font and paper size the current (active) choices, click the OK
button. To disregard the selections and close the dialogue, click the Cancel button.
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4.3.2

4.3.3

4.3.4

435

4.3.6

Printing an Entire Proposal

To print acomplete proposal, including al observations, choosethe Proposal menu
entry from the Print submenu in the File menu of the Main Panel (see Fig. 7). A
Print dialogue will appear which will allow you to select a destination for the print
job (printer or file) and to start the print job. The exact appearance of this dialogue
will depend on the platform you are using.

Printing Admin Details

The data entered in the Admin Details Panel (see section 5.2, page 15) can be
printed separately by choosing the Print menu entry from the Panel menu of the
Admin Details Panel.

Printing Proposal Details

The dataentered in the Proposal Details Panel (section 5.3, page 16) can be printed
separately by choosing the Print menu entry from the Panel menu of the Proposal
Details Panel.

Printing Observations

The Print submenu in the Panel menu of the Observation Details Panel (see Fig. 6)
allows you to print individual observations or all the observationsin the proposal.

To print an individual observation, make sure the observation is displayed in the
Observation Details Panel (see section 5.4, page 17) and choose the Current
Observation menu entry from the Print submenu, described in the previous
paragraph. To print all the observations, choose the All Obser vations menu entry
from the same menu.

Printing the Observation Summary

A summary of all the observationsin the proposal (one observation per line) can be
printed by choosing the Summary menu entry from the Print submenu in the Panel
menu of the Observation Details Panel (see Fig. 6).
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5.2

Entering Data
The Main Panel

When the PGT isfirst started, it isthe Main Panel which is displayed. This panel
actslike the parent for al other panels and it isfrom this panel that you can access
the other panels which make up the PGT.

~i ISOC PGT: Main Panal | - iJ
File Help

esa

Admin Details Panel

|

Proposal Details Panel

These buttons open other

Observation Details Panel panelsin the PGT

Target Visibility Predictor

| Ohservation Time Estimator
| Press this button to check your proposal

Check Proposal

| SubmitProposalto1soc |

5--Prupusal M

Il This section allows you to
: : ’ submit or resubmit your
Dronnealtn o | proposal

Figure12 TheMain Panel

The Main Panel is divided into two sections. The top half of the panel contains
buttons which open other panels. These panelsare described in later sections of this
document. In addition, thereisa Check Proposal button which will run through a
series of checks on your proposal and list anything which is wrong or incomplete.
This check can be performed at any time.

The lower half of the Main Panel is devoted to proposal submission. With the
Submit Proposal to | SOC button you are ableto electronically send your proposal,
viathe Internet, to the ISOC. See section 7, page 24, for more details on submitting
aproposal.

The Admin Details Pandl

To open the Admin Details Panel, select the Admin Details Panel button on the
Main Panel. When the panel first appears, only the upper part of the body of the
panel isvisible. To see the lower part, click in the empty space below the scrollbar
on the right-hand side of the panel.
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= ISOC PGT: Admin Details Panel
Panel Help
”\:"}(@:‘ e Science Operations Centre
Principal Investigator Detail:
rTitle ———— "First N (=) "Surname
FPostal Address
rDepartment

rinstitute

r Street

rCity ar Toawn

r State Paostal or Zip Code Gy

[ [ | = “ Click hereto

| see the lower
/ part of the
rE-mail Address pa"lel
rTelephone Number "Fax NMumber
-

Figure13 The Admin Details Pand (upper part)

The Admin Details Panel contains fields which are used for administrative
purposes. They are self-explanatory. The lower part of the panel concerns co-
investigators and data distribution. Asthisis also self-explanatory, the lower part
of the panel is not shown in this document.

53 The Proposal Details Panel

To open the Proposal Details Panel, select the Proposal Details Panel button on
the Main Panel (see Fig. 12). Aswith the Admin Details Panel, this panel is sized
to show only the upper part of the body of the panel when first opened.

531 Attaching the Scientific Justification

At the bottom of the Proposal Details Panel is a button marked New Attachment.

Scientific Justification
rProposal Category
rCurrent Attachment

| | Mew Attachment || I

Figure14 Adding Attachments
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5.4

54.1

Pressing this button will open the Attach dialogue, a dialogue very similar to the
Open dialogue described in section 4.2, page 12. Y ou can use thisdialogueto attach
ascientific justification, but only if the file containing your scientific justification
isin PostScript or PDF format.

= |
Look in: | ] Attachments - | | £ oo .
— Attachments must be
D sci_just. pdf -«—— in PostScript or PDF
D sci_just.ps format
FiE memes |sc:iJust.pdf | | Attach |
Files of type: |AII Files .} - | | Cancel |

Figure15 The Attach Dialogue

Once you select the Attach button, the name of your attachment will be shown in
the Current Attachment box of the Proposal Details Panel (see Fig. 14). If you save
your proposal, the attachment will be saved with it (in compressed form), so there
is no need to re-attach the file every time the proposal is loaded. However, if you
make changes to your scientific justification after attaching the file to your
proposal, you will need to re-attach the changed file.

Notethat it isnot possibleto remove an attachment onitsown (you can select Reset
from the Panel menu and thiswill remove the attachment, but it will also clear the
other fields). However, you can replace the existing attachment with another one at
any time, ssimply by using the Attach dialogue again.

The Observation Details Panel

To open the Observation Details Panel, select the Observation Details Panel
button on the Main Panel (see Fig. 12). Aswith the Proposal Details Panel, this
panel is sized to show only the upper part of the body of the panel when first
opened.

Observation Numbering

Each observation in a proposal is numbered sequentially, as shown in the Number
field on the left of the tool bar at the top of the panel (see Fig. 16). Here, you can
see the number of the currently displayed observation and the total number of
observations in the proposal.

Whenever an observation is added to a proposal, it is added at the end of thelist.
For example, adding an observation to a proposal which contains ten observations
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will result in the new observation being given the number eleven. When removing
an observation, those observations with a higher number than the observation
which was removed will have their numbers reduced by one. For example,
removing observation number five from aproposal which containsten observations
will result in observation numbers six to ten being renumbered five to nine
respectively.

Navigation buttons

IS0C PGT: Observation Details Panel .
Tool bar Panel Observation Help |
\ = The sum of the
\ INTEGRAL durationsin all
L Science Operations Centre observationsin
this proposal
rMumber Total Time
The current Eof 10 | First ||| Previous ||| Mext ||| Last || A e
observation ___ I 2 I
number and m Y
the total number (GleerssEE [
of observations Ehscryation
in the proposal _
’—Duratlon rDither Pattern
. al | ]
Observation Type
| r Preferred Orientation
’V| vm From To
Show Justification ] “ Heg “ deg
Source
rRA (J2000)
I rHr Min Sec
rV Magnitude —— I h h I
|19.? rDEC {J2000}
rSign Dor s s e Click hereto
Energy Band—————— see the lower
Min Max J “ “ “ - ) " S;tdof the
“15 keV “10000 keV -
“Extent Extension
it | Point - || i i
’VIOEO photonsfcm2/s h deg h deg
Figure16 The Observation Details Panel (upper part)
54.2 Displaying Observations

Only one observation may be displayed at atime. To display a different
observation, use the navigation buttons on the tool bar. The First button always
causes observation number one to be displayed. The L ast button causes the last
observation which was added to the proposal to be displayed (thisis alwaysthe
observation with the highest number, because observations are always added to the
end of thelist). The Next button causes the current observation number to increase
by one, i.e. pressing this button repeatedly will cause each observation to be
displayed in numerical order. The Previous button worksin the reverse manner to
the Next button, i.e. the current observation number will be decreased by one. Note
that this button does not necessarily return you to the observation you were looking
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5.4.3

5.4.4

5.4.5

at previoudly, so if the proposal contains three or more observations and you click
the Fir st button, then the L ast button and then the Pr evious button, you will not be
looking at observation number one, but rather, observation number n-1, wherenis
the number of observationsin the proposal.

The Observation Menu

The Observation Details Panel has an additional menu, named Observation.

SC 2]
Panel Observation Help |
ee Add INTEGRAL
W Delete Science Operations Centre
Mumber— puplicats Total Time
Check I
|1 of 1 i IO ks
Go Ta
Observation Detail b
I =

Figure17 The Observation Menu

Using this menu you can manipulate observations in your proposal. The menu
entries should be self-explanatory: to add a new observation, select Add (the
display will show the new observation); to remove the currently displayed
observation, select Delete; to copy the currently displayed observation, select
Duplicate (the display will show the copied observation); to check the currently
displayed observation, select Check; to display a particular observation, select Go
To.

I nstrument Settings

In the lower half of the Observation Details Panel you can choose certain
instrument settings. The number of modes and parameters available will depend on
the privileges allowed in the version of the PGT you are using. For example, the
Genera Observer (public) version of the PGT only allows two parameters for the
JEM-X 2 instrument to be set and the choice of two modes for the OMC instrument.

If an instrument has only one mode available for selection, the Mode pick-list for
that instrument will be disabled, as there is no choice to make. Similarly, if there
are no parameters to set for an instrument, the Par ameter s button for that
instrument will be disabled.

JEM-X TM Formats

If you click the Parameter s button for the JEM-X 2 instrument, the Mode
Parameters panel for that instrument will be displayed. This panel allowsyou to set
the Primary and Secondary TM Formats. The allowed Secondary TM Formats are
dependent on the Primary TM Format selected and correspond to a matrix of
allowable Primary and Secondary TM Format combinations, see RD-10 and RD-
11.
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~iJEM><—2 Mode P - iJ
Panel Help

Full Imaging - | The list of Secondary T™M
| Formats varies depending

~Secondary TM Format-— / ‘[l)'rR/l thFeO(r:Ll%[ce of Primary
Current observation RESEEIIETN - |

number
\ EObser\ratiom

Figure 18 JEM-X 2 Mode Parameter s Panel
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6.1

OnlineTools

Two online tools are provided to aid proposal writing: the Observation Time
Estimator (OTE) and the Target Visibility Predictor (TVP). To useeither tool, your
computer must be connected to the Internet.

Observation Time Estimator

I ISOC PGT: Observation Time Estimator
Panel Help
esa INTEGRAL
Science Operations Centre
rinstrument Dither Pattern
|IBIS v“ M Staring v||
rCantinuum Energy (keV)—— rLine Energy {keV}
"Min "Max |V"Energy "Width

rFlux (photons!cmz.rs)—‘ "Signal o Noise—‘ "Exposure Time {ks) —

rRight Ascension {decimal degrees)—‘ "Declination {decimal degrees} —

| | Click the Fetch Results
button to send your

| inputsto ESTEC. The
M results will appear in

aseparate panel.

Figure19 TheOTE Panel

Inputsto the OTE should be chosen from the pick-listsand/or entered into the boxes
provided. Some boxes have mutually exclusive relationships between them; they
are the Continuum Energy and Line Energy boxes, and the Sgnal to Noise and
Exposure Time boxes. For example, if you enter avaue into either of the
Continuum Energy boxes, the Line Energy boxeswill be disabled. To re-enablethe
Line Energy boxes, delete the text from the Continuum Energy boxes. Similarly, if
you enter avalue into the Sgnal to Noise box, the Exposure Time box will be
disabled. To re-enable the Exposure Time box, delete the text from the Sgnal to
Noise box.

The PGT will not perform any checking of the values you enter (all checkingis
performed remotely by the OTE), so you should note the following points:

* Oneof either the Sgnal to Noise or Exposure Time fields must be completed
* The OTE will accept valuesin exponential format e.g. 1e-6 or 1E4
» The Sgnal to Noise ratio should be entered as a number i.e. 3 not 3:1

* The Right Ascension and Declination fields are optional and may be left
blank

When you have completed al the relevant fields and you wish a calculation to be
performed, click the Fetch Results button. The PGT will then attempt to contact
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ESTEC, viathe Internet, and pass your inputs as arguments to the OTE running
remotely on amachine at ESTEC. When the calculation has been performed, the
OTE will return the results and they will be displayed in a separate panel.

To perform another calculation, change the inputs as required and click the Fetch
Resultsbutton again. Theresultswill be displayed in anew panel, leaving your old
results available for comparison.

6.2 Target Vishbility Predictor
I150C PGT: Target Wisibility Predictor
Panel Help |
INTEGRAL
esa Science Operations Centre
Target Infarmation — Visibility Information
rRight Ascension {(HH:MM:55.55) — rStart Date (DD/MMMYY YY)

rDeclination {(+DD:MM:55_5)

rEnd Date {DD/MMYY YY) —
| |

rDither Pattern

rMinimum Duration {s}
|Staring - || |

Fetch Results

Figure20 TheTVP Panel

Inputsto the TV P should be chosen from the pick-list and/or entered into the boxes
provided.

The PGT will not perform any checking of the values you enter (all checking is
performed remotely by the TVP), so you should note the following points:

* The Right Ascension and Declination may be entered in two formats: either
as a decimal value in degrees, or as hours:minutes.arcseconds (for RA) or
degrees:minutes.arcseconds (for DEC), where the values are separated by
colonsor spaces. If you include the sign (either + or -) for Declination, make
sure there is no space (or any other character) between the sign and the de-
grees value

* All fields must be completed

When you havefilled in al the relevant fields and you wish a calculation to be
performed, click the Fetch Results button. The PGT will then attempt to contact
ESTEC, viathe Internet, and pass your inputs as arguments to the TV P running
remotely on amachine at ESTEC. When the cal culation has been performed, the

TVP will return the results and they will be displayed in a separate panel (see Fig.
21).
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To perform another calculation, change the inputs as required and click the Fetch
Results button again. Theresultswill be displayed in anew panel, leaving your old
results available for comparison.

esa INTEGRAL
Science Operations Centre

15.514375 (01:02:03.45)
1.0342778 (+01:02:03.4)
2002-Dec-10 00:00:00 GMT

2002-Dec-10 23:52:52 GMT /
Staring
10000

Right A=zcenzion
Declination
Start Date

End Date

Dither Pattern

Minimum Duration

Z002-Dec-10 00:00:00 GMT -> Z002Z-Dec-11 08:57:02 GMT (118622
Z002-Dec-15 21:54:52 GMT -> Z002-Dec-18 00:55:26 GMT (183 634)
Z002-Dec-18 07:43:25 GMT -> Z002-Dec-21 00:42:22 GMT (233244)
Z002-Dec-21 07:30:51 GMT -> Z002-Dec-24 00:283:38 GMT (233867)
Z002-Dec-24 07:16:55 GMT -> Z002-Dec-27 00:16:03 GMT (233248)
Z002-Dec-27 07:04:02 GMT -> Z002-Dec-30 00:03:08 GMT (2333332
Z002-Dec-30 06:51:43 GMT -> Z003-Jan-01 23:48:42 GMT (233812
Z003-Jan-02 0&6:37:28 GMT -> Z003-Jan-04 23:36:12 GMT (233 3224)
Z003-Jan-05 06:24:34 GMT -> Z003-Jan-07 13:05:31 GMT (128357)
Z003-Jan-08 06:13:51 GMT -> 2Z003-Jan-08 17:56:17 GMT (42148)
Z003-Jan-12 03:04:14 GMT -> Z003-Jan-13 23:04:50 GMT (155436)
Z003-Jan-14 05:53:16 GMT -> Z003-Jan-16 22:52:11 GMT (23332335)
2003-Jan-17 05:40:52 GMT -> Z003-Jan-12 22:38:24 GMT (233852)

4]

Figure21l TVP ResultsPanel
6.3 Printing Results

If you wish to print the results of a calculation made by the OTE or the TVP, it is
recommended that you select the “Monospaced” font, using the Print Options
dialogue (see section 4.3.1, page 13). Thiswill ensure that columnsline up properly
and will make the printout more readable.
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7.1

Submitting a Proposal to 1SOC

The PGT allowsyou to send your proposal electronically to the ISOC. In order for
thisto work, your computer must be connected to the Internet.

Submitting for the First Time

The lower half of the Main Panel (see Fig. 12) alowsyou to submit your proposal
to the ISOC when it is complete and you are happy with it.

Clicking the Submit Proposal to 1 SOC button starts the submission process. First,
the PGT will check your proposal. If it failsany checks, the submission processwill
be aborted and you will need to correct the errors shown in the Failed Checks Panel.
If it passes the checks, a panel is displayed showing a summary of the proposal.
Click Submit to send the proposal, Cancel to abort the submission.

~i Summary Panel I |

If your Scientific Justification file has been modified since you attached it, please re-attac...

Total Observation Duration: 100000
Total Number of Observations: 1

Chbservation #1 :
Chbservation Duration: 100000
Target Hame: ohservation
RA/Dec (J2000): 11h 12m 13s +1d 2m 3s
Chservation Type: Normal
Dither Pattern: x5

Warning: Gnly the above sources will be considered for approval.
| Submit | | Cancel

Figure22 The Summary Panel

If you click Submit, the PGT will attempt to establish contact with a computer at
the ISOC which has been set up to receive proposals. Once contact is established,
your proposal will be sent. If the proposal was sent successfully, the dialogue
shown in Fig. 23 will be displayed.

Submit Proposal

Proposal submitted successfully.

o
I

You should receive e-mail coanfirmation shortly.
{Please contact ISOC Help Desk if you do not

receive e-mail canfirmation within 24 hours. )

Figure23 Successful Submission Dialogue

When it receives your proposal, the computer at the ISOC will check the proposal
(these checks are different from those performed by the PGT) and return an email
message to you confirming receipt and providing a Proposal 1D for your proposal
(youwill need this1D if you want to resubmit the proposal). The message will also
tell you whether your proposal has been accepted (it passed the checks) or rejected
(it failed the checks).
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1.2

7.3

Repeating a Submission

If you realise you have made a mistake, or you just want to make changesto a
proposal you have aready submitted, you can resubmit a proposal using the
Proposal ID you received when you submitted the proposal for the first time.

Make the changes you wish to make to the proposal and enter the Proposal ID in
the box provided at the bottom of the Main Panel (see Fig. 12). The Resubmit
Proposal to | SOC button will be enabled and the Submit Proposal to 1SOC
button will be disabled (to prevent you pressing the wrong button). When you click
the Resubmit Proposal to I SOC button, the PGT will repeat the proposal
submission process, described in section 7.1.

The computer at 1SOC will use the Proposal 1D you provide to find your old
proposal in the ISOC database. If it is found, your amended proposal will replace
the old one in the ISOC database. If it can’t be found, the email message which is
returned to you will inform you of that fact (make sure you have entered the
Proposal ID correctly).

NOTE: The PGT cannot prevent you submitting the same proposal multiple times.
Each time you submit a proposal, you will receive anew Proposal ID. It isnot
possible to undo a submission, so if you want to avoid having duplicate (or very
similar) proposalsin the ISOC database (each of which will be reviewed by the
TAC), use the Resubmit Proposal to | SOC button when you need to make
changesto a previously submitted proposal.

Obtaining a Copy of a Submitted Proposal from ISOC

Once you have submitted your proposal, you should save it (see section 4.1, page
12) to ensure you have a copy on your local system for your own reference, or to
allow you to resubmit the proposal at alater date.

However, lifeisfull of surprises and mistakes happen occasionaly, so if you
accidentally delete your proposal, or your machine catchesfire, do not despair! Y ou
can request a copy of your proposal by sending an email to the ISOC Helpdesk at
the email address shown in section 1.5, page 1. Just state in the body of the message
that you would like a copy of your proposal and give the Proposal ID of the
proposal. The proposal will be emailed to you at the email address you entered into
the proposal. If thisemail addressiswrong, you should provide the correct address
in your email to the Helpdesk.
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Extra Features
Autosave

To prevent you losing precious hours of work through a problem with your
computer, an autosave feature is available which will automatically save your
proposal every so often. The frequency at which your proposal is saved and thefile
name used for the saved proposal can be defined by you.

The autosave featureis enabled by editing the PGT .lax filein your PGT installation
directory. Open the PGT.lax file in an editor and find the following lines:

Aut osaveSeconds=0
Aut osaveFi | e=

By default, the autosave feature is disabled. To enable autosaving, set the

Aut osaveSeconds Vvariableto avalue which represents the number of seconds you
would like to elapse between successive saves of your proposal. For example, to
have your proposal automatically saved every five minutes, edit the line to read:

Aut osaveSeconds=300

Y ou must also specify afilename for the saved proposal by editing the

Aut osaveFi | e variable. For example, to save the proposal as“my_proposal” ina
directory called “tmp” (which must already exist) on the top level of your disk
drive, you would edit the line as follows:

OnaUNIX system:

Aut osaveFi | e=/t nmp/ ny_pr oposa

On aWindows system:

Aut osaveFi | e=C:. /t np/ nmy_pr oposa

NOTE: Use/ (dash) characters, not \ (backslash) characters and do not put spaces
around the = (equals) symbols.

Changing the Mandatory Item Colour

By default, the background colour for mandatory itemsis cyan. This can be
changed by editing the PGT .lax filefound in your PGT installation directory. Open
the PGT.lax filein an editor and find the following line:

Mandat or yl t emCol our =Cyan
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The colour specified to the right of the equals symbol may be set to one of the
following values:

Bl ack, Bl ue, Cyan, Dar kG ay, Gr ay, Gr een, Li ght Gray, Magent a, Or ange, Pi nk,
Red, Wi t e Or Yel | ow.

NOTE: These names are case sensitive. Do not put spaces anywhere on the line.

The text colour is aways black, so setting Mandat or y1 t enCol our =Bl ack iS not
terribly useful. Similarly, the non-mandatory colour is always white, so setting
Mandat or yI t enCol our =Wi t e means you will not be able to tell the mandatory
items from the non-mandatory items.
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Appendix A: Keyboard Shortcuts

A.l Main Panel
Table 1: Main Panel Keyboard Shortcuts

Key Press Function
ALT-A Open the Admin Details Panel
ALT-C Check Proposal
ALT-E Open the Observation Time Estimator
ALT-F Open the File menu
ALT-FE Exit the PGT
ALT-FO Open the Open dialogue
ALT-FP Open the Print submenu
ALT-FPO Open the Print Options dialogue
ALT-FPP Print the Proposal
ALT-FS Open the Save dialogue
ALT-H Open the Help menu
ALT-H A Open the About dialogue
ALT-HO Open the Overview Panel
ALT-H N Open the Main Panel Help
ALT-O Open the Observation Details Panel
ALT-P Open the Proposal Details Panel
ALT-V Open the Target Visibility Predictor
CTRL-E Exit the PGT
CTRL-H Open the Main Panel Help
CTRL-O Open the Open dialogue
CTRL-S Open the Save dialogue
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A.2 Admin Details Panel
Table 2: Admin Details Panel Keyboard Shortcuts

Key Press Function
ALT-H Open the Help menu
ALT-HN Open the Admin Details Panel Help
ALT-HO Open the Overview Panel
ALT-P Open the Panel menu
ALT-PE Close the Admin Details Panel without losing data
ALT-PR Reset the Admin Details Panel fields to their default settings
ALT-PT Print the admin details
CTRL-E Close the Admin Details Panel without losing data
CTRL-H Open the Admin Details Panel Help
CTRL-P Print the admin details
CTRL-R Reset the Admin Details Panel fields to their default settings

A.3 Proposal Details Panel
Table 3: Proposal Details Panel Keyboard Shortcuts

Key Press Function
ALT-H Open the Help menu
ALT-H N Open the Proposal Details Panel Help
ALT-H O Open the Overview Panel
ALT-P Open the Panel menu
ALT-PE Close the Proposal Details Panel without losing data
ALT-PR Reset the Proposal Details Panel fields to their default settings
ALT-PT Print the proposal details
CTRL-E Close the Proposal Details Panel without losing data
CTRL-H Open the Proposal Details Panel Help
CTRL-P Print the proposal details
CTRL-R Reset the Proposal Details Panel fields to their default settings
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A4 Observation Details Panel
Table 4: Observation Details Panel Keyboard Shortcuts

Key Press Function
ALT-H Open the Help menu
ALT-HN Open the Observation Details Panel Help
ALT-HO Open the Overview Panel
ALT-O Open the Observation menu
ALT-OA Add an observation to the proposal
ALT-OC Check the current observation
ALT-OD Delete the current observation from the proposal
ALT-OG Go to a specific observation
ALT-OU Copy an observation and add it to the proposal
ALT-P Open the Panel menu
ALT-PE Close the Observation Details Panel without losing data
ALT-PR Reset the Observation Details Panel fields to their default settings
ALT-PT Open the Print submenu
ALT-PTA Print the details of all observations
ALT-PTC Print the details of the current observation
ALT-PTS Print asummary of all observations
CTRL-E Close the Observation Details Panel without losing data
CTRL-H Open the Observation Details Panel Help
CTRL-P Print all observation details
CTRL-R Reset the Observation Details Panel fields to their default settings
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A5 Observation Time Estimator Panel

Table5: OTE Panel Keyboard Shortcuts

Key Press Function
ALT-F Fetch Results
ALT-H Open the Help menu
ALT-HN Openthe OTE Help
ALT-H O Open the Overview Panel
ALT-P Open the Panel menu
ALT-PE Close the OTE panel without losing data
ALT-PR Reset the OTE panel fieldsto their default settings
CTRL-E Close the OTE panel without losing data
CTRL-H Open the OTE Help
CTRL-R Reset the OTE panel fieldsto their default settings

A.6 Target Visbility Predictor Panel
Table 6: TVP Panel Keyboard Shortcuts

Key Press Function
ALT-F Fetch Results
ALT-H Open the Help menu
ALT-H N Openthe TVP Help
ALT-H O Open the Overview Panel
ALT-P Open the Panel menu
ALT-PE Closethe TVP panel without losing data
ALT-PR Reset the TV P panel fields to their default settings
CTRL-E Close the TV P panel without losing data
CTRL-H Openthe TVP Help
CTRL-R Reset the TV P panel fields to their default settings
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